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The Internet

The Internet is a computer network made up of thousands of networks world-wide.  No one knows exactly how many computers are connected to the Internet.  It is certain, however, that these numbers are in the millions and more are added every day.


No one is in charge of the Internet.  There are organizations that work on technical aspects of the network, but no one group is in control.  Internet traffic flows through routers that send data to different computers connected to the Internet.

TCP/IP is the protocol that is used for the Internet.  A protocol is just a standard by which something is done.  TCP/IP works by sending data in packets to computers connected to the Internet.  If you are downloading a file or loading a web page, the files needed are split up into chunks and sent to you chunk by chunk.  Chunks are referred to as packets.
Some important concepts when talking about the Internet follow.

Servers & Domains

· domain name – specifies where a web page is located

· URL – Uniform Resource Locator, tells you where you can find something on the Internet (basically a web page’s address) 

· a domain name points the browser to an IP address
· an IP address is the number assigned to a computer that is connected to the Internet, each computer connected to the Internet has a different IP address or number 

· an IP address consists of four numbers, each separated by a period, each number can be between 0 and 255 (eg. 123.120.3.16) 

· web pages are located on a server computer that is connected to the Internet directly. Server computers are generally kept on (turned on) all the time so that the web pages on the server are always accessible. 

· when you specify a domain name you are actually specifying what server computer the web page you are looking for is located on

for example:

www.ucalgary.ca is the URL where the University of Calgary’s web page is

ucalgary.ca is the domain name, and therefore we are looking for the web page on the server computer pointed to by ucalgary.ca

HTML Files

· hypertext is a document containing words that connect to other documents, the connections are called links

· web pages are just files like a Word document or Excel spreadsheet

· web page filenames MUST end in .html or .htm 
· pictures displayed on a web page are usually either a jpeg (Joint Photographic Expert Group) image or a gif (Graphical Interchange Format) image

for example:

myWordFile.doc (doc means it is a Word document)

myExcelFile.xls (xls means it is an Excel spreadsheet)

myWebPage.html (html means it is a web page viewable in Netscape or Internet Explorer)

myWebPage.htm (means the same thing as html)

Directories 

· if you see a / (slash) in a URL this just means that a file or web page is located inside a directory on the server computer

for example:

www.cpsc.ucalgary.ca/~carman/

this URL says that my web page is on the CPSC server in a directory called carman.

HTML

· Hyper Text Markup Language - is a computer language used to design web pages 

· to view HTML code used to create a web page: 

· in Internet Explorer, go to the Edit menu and then to View Source or right click on a page and go to View Source in the menu that appears 

· in Netscape, go to the Edit menu and View Source

· HTML uses TAGS to format text 

· a web page file (html file) is just text that you want displayed on the screen with formatting tags around the text 

· the formatting tags change the text you want to show up, making it bigger, smaller, bold, italic, centred, etc. 

· tags contain the format property you want inside pointy brackets < format type > 

· there are usually two tags for each format, the first one starts the format and the second one finishes it 

· the second tag to close a format has a slash inside the tag < / format type >

for example:

 <BOLD> This text will be bold. </BOLD>

Where Do I Create a Web Page?
· You can type HTML code by opening up a web page file in Notepad. To do this though, you must make your entire web page using just HTML code. 

· You can create your web page in Microsoft Word and then in the File menu, use Save as HTML to convert your Word document to a web page file 

· You can create your web page in Netscape Composer. It has design tools that allow you to add features usually found on web pages. There is a web page toolbar at the top of Composer and special menus for adding things such as links and graphics to your web page.

Check out these web sites to learn more about creating web pages:

www.cutehtml.com (Cute HTML Editor)
tucows.oanet.com/htmlbeginner95.html (Beginner HTML Editors)
tucows.oanet.com/htmledit95.html (Advanced HTML Editors)

http://www.ucalgary.ca/it/itf/general/web/web-01.html (U of C Information Technology)

Check out these web sites for background images:

http://www.grsites.com/textures/

http://www.pixelfoundry.com/bgs.html

The Rest is Tags

The rest of HTML is just learning what tags you need to perform the desired formatting.  The number of tags in use continues to expand.  Here are some of the more general ones and a sample format of a web page.

<HTML> specifies the start and end of an html file, your entire page is between these tags  </HTML>
<HEAD> this is the heading of your page.  Place items like a title between these tags </HEAD>
<TITLE> The title you want displayed at the top bar of your window goes here </TITLE> 

<BODY>  All the normal text you want displayed on a web page goes in here </BODY> 

<BODY BGCOLOR=”red”> a body tag with a background colour </BODY>

<BODY BACKGROUND=”mypicture.jpg”> a body tag with a background picture </BODY>

<BODY BGCOLOR=”red” VLINK=”red” LINK=”blue”> a body tag with colours specified for “viewed” links and “non-viewed” links </BODY>

<BODY TEXT=”red”> a body tag setting the default text colour to red </BODY>

<BOLD> This text will be bold </BOLD> 

<I> This text will be italicized </I> 

(this is a capital letter i in case the font makes it unclear) 
<U> This text will be underlined </U> 

<CENTER> This text will be centred on the page. Note the tag needs US spelling of centre.</CENTER> 

<BR> this tag acts as an enter key, any text after it starts on a new line (HTML won't display tab key presses or enter key presses when you are coding a web page. It will only display spaces) 
<HR> draws a horizontal ruler line across the page 
<FONT FACE="MS Sans Serif" SIZE=”+5” COLOR=”red”> This text will have a different font face, size, and colour. Note US Spelling of colour. </FONT> 

<IMG SRC="mypicture.jpg"> this tag displays a picture on your web page 
You can see that the above tags usually have a start tag and a finish tag. Everything between start and finish is formatted according to the tag. You can have tags nested inside of each other as well.

For example:

 <BOLD><CENTER>This text will be bold and centred</BOLD></CENTER>

a bulleted listed can be created using code like this:

<UL>

<LI>Item 1

<LI>Item 2

</UL>

a numbered list can be created using code like this:

<OL>

<LI>Item 1

<LI>Item 2

</OL>
the <UL> tag starts the bulleted list, each <LI> tag specifies where a bullet will appear. The </UL> tag tells where the bulleted list ends.

Sample Web Page

By combining the mentioned tags we can create a simple web page.  This structure should better help you to understand how the tags are actually used on a page.  The indentation is not necessary, but it helps to see the beginning and ending tags for each format.

Here is a complete simple web page:

<HTML>

<HEAD>



<TITLE>My First Web Page</TITLE>

</HEAD>

<BODY BGCOLOR=”black” LINK=”red” VLINK=”blue” TEXT=”white”>


<CENTER>


<FONT SIZE=”+6”>Welcome to My Web Page</FONT>

</CENTER>

<BR><BR>

This is a picture of me: 

<BR>

<IMG SRC=”mypicture.jpg”>

</BODY>

</HTML>
A good exercise would be to type in this sample page and be sure to understand the different tags used.

Hyperlinks

The web is an interconnection of millions of web pages.  To be connected to other pages though, we must first create links to them.  This is done by creating a hyperlink.  A hyperlink is normally what you click on to go to another web page.  It can be some text or even a picture.  

Here are some example hyperlinks and the HTML to create them:

<A HREF="http://www.hotmail.com"> this text will be underlined with blue and will be a link to another web page, clicking on it will take you to that web page </A> 

<A HREF="mailto:carman@cpsc.ucalgary.ca"> this text if clicked on will open up a window to send me an email message</A>
<A HREF="page2.html"> this text will be underlined with blue and will be a link to another web page, clicking on it will take you to that web page </A>
<A HREF=”http://www.hotmail.com”><IMG SRC=”mypicture.jpg”</A>

This will create a link around a picture.  You can click on the picture to go to the specified web page.
Tables

A great way to display information or align objects in a web page is by using tables.  A table looks something like this, but can contain words or pictures.
















Here are the HTML tags for tables: (replace # with any number, replace % with any percentage)
<TABLE></TABLE>
Creates a table

<TR></TR>
Creates a row in a table

<TD></TD>
Creates a cell in each row

<TABLE BORDER=#>
Sets the border width of the table

<TABLE CELLSPACING=#>
Sets the amount of space between cells

<TABLE CELLPADDING=#>
Sets the amount of space between a cell’s border and its contents

<TABLE WIDTH=# or %>
Width of the table in pixels or percentage of page

<TD BACKGROUND=”mypicture.jpg”>
Sets a background picture for a cell

<TR ALIGN=”LEFT”> or <TR ALIGN=”RIGHT”> or <TR ALIGN=”CENTER”>

TR can be replaced by TD to align an individual cell
Sets the horizontal (left-right) alignment of the row or column

<TR VALIGN=”TOP”> or <TR ALIGN=”MIDDLE”> or <TR ALIGN=”BOTTOM”>

TR can be replaced by TD to align an individual cell
Sets the vertical (up-down) alignment of the row or column

<TD COLSPAN=#>
Sets the number of columns a cell should span

<TD ROWSPAN=#>
Sets the number of rows a cell should span

<TD NOWRAP>
Prevents the lines within a cell from being broken

Example of the HTML code for a table:

<HTML>


<TABLE BORDER=1 CELLPADDING=10 CELLSPACING=10>



<TR>




<TD>Red</TD>




<TD>Blue</TD>



</TR>



<TR>




<TD>Green</TD>




<TD>Orange</TD>



</TR>


</TABLE>

</HTML>
The resulting table should look like this:
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Frames

Frames can separate one main web page into multiple pages.  Each frame in a web page is a page itself.  Normally people use frames to display menus on their web pages.  It is important to be careful when using frames.  Often they are used incorrectly and end up making the page look worse than before.  Use them with caution and don’t let any one frame take up too much space on your page.

This is an example web page using frames:
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Here are the HTML tags for frames:

FRAMESET> </FRAMESET>
tag in a frames document; can also be nested in other framesets

<FRAMESET ROWS="VALUE,VALUE">

defines the rows within a frameset, using number in pixels, or percentage of width

<FRAMESET COLS="VALUE,VALUE">
defines the columns within a frameset, using number in pixels, or percentage of width

<NOFRAMES></NOFRAMES>
defines what will appear on browsers that don't support frames

<FRAME NAME="NAME">
specifies which HTML document should be displayed

<FRAME MARGINWIDTH=#>
defines the left and right margins for the frame; must be equal to or greater than 1

<FRAME MARGINHEIGHT=#>
defines the top and bottom margins for the frame; must be equal to or greater than 1

<FRAME SCROLLING=VALUE>
sets whether the frame has a scrollbar; value may equal "yes," "no," or "auto. " The default, as in ordinary documents, is auto.

<FRAME NORESIZE>
prevents the user from resizing a frame

Example of index page for frames: (each frame must be an html file)

<HTML>

<HEAD>

<TITLE>My Frame Page</TITLE>

</HEAD>

<FRAMESET COLS="190,*" FRAMEBORDER="0" BORDER="0">

        
<FRAME SRC=”menu.html” NAME="menu"   NORESIZE>

        
<FRAME SRC=”display.html” NAME="display" NORESIZE>

</FRAMESET>

<NOFRAMES>

<CENTER><H1>

Sorry, your browser does not support frames.  This website was designed specifically for frames.  Download a newer version of Netscape Communicator or Internet Explorer.

</CENTER></H1>

</NOFRAMES>

</HTML>
Example of Loading a Page in a Frame:

<A HREF="newPage.html" TARGET="display">
Midi Sound

<BGSOUND SRC="MYMUSIC.MID" LOOP=1>

<EMBED SRC ="MYMUSIC.MID" HIDDEN=FALSE AUTOSTART=TRUE HEIGHT=60 WIDTH=144 VOLUME=50% LOOP="NO">
Putting Your Page on the Internet

The final stage is putting your web page on the Internet.  Right now it is just on your computer hard drive or a floppy disk.  To have people see your web page around the world you must put it on a web server.  Servers were talked about in the beginning of these notes.  You first need an account on a web server to be allowed to place pages there.

Some free web hosting URLS are:

http://geocities.yahoo.com/home/

http://angelfire.lycos.com/
If you have an account with a web host then you can put your web page on their web server.  Usually they will have a utility to upload your web pages files to the web server.  If you make any changes to your web page, you must send the files to the web server again.

Here is a visual summary of the key concepts about updating your web page and placing it on a web server.
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� Web Monkey – The Web Developer’s Resource (http://hotwired.lycos.com/webmonkey/reference/html_cheatsheet/)


� Web Monkey – The Web Developer’s Resource (http://hotwired.lycos.com/webmonkey/reference/html_cheatsheet/)
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